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Xilinx ISE 10.1 Tutorial
(Building a Half Adder)
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Introduction

In this tutorial, you will build a simple half adder, as shown below.
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The following pages have screenshots that will guide you through the design, testing,
and implementation phases. Use this as a reference throughout the semester.
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General Xilinx Tips

1. SAVE EARLY AND OFTEN
Xilinx is notorious for crashing at the most inopportune times. Do yourself a
favor and save.

2. Atthe end of a lab session (or any work session), archive your project using the
Xilinx utility (this will ensure you save everything), and save this zip archive
on your ENIAC drive or on a flash drive. Do NOT assume files will remain
on the lab computers or that “your” computer will be available at a later time.

3. Make sure all components are connected. Loose wires are a frequent cause of
problems.

4. Try your hand at debugging first before calling a TA. You will learn a lot by
struggling through problems that seem hard at first.

5. Read all instructions carefully before starting the lab. Often, there will be a little
detail that ends up being very important.

6. Make sure you test all important cases, particularly edge/corner cases. You can
be sure that your TA will test these as part of the demo.
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Creating a Project

First, you will have to create your project. Follow the steps below to start the
program and create a new project.

1. Goto Programs - ESE Lab Software - Xilinx ISE 2 ISE and click on
“Project Navigator”

2. Click on File > New Project
3. Before you name your project, type in the project location as “C:\user\yourname”
4. Name your project MYHA (this will append “MYHA” to your path)
5. Set the “Top-Level Source Type” to “Schematic”
6. Your screen should look like the image below.
7. Click “Next”
ﬂ Mew Project Wizard - Create New Project ﬁ

Enter a name and location for the project
Project name: Project location
MYHA C:\user\ YOURNAME\MYHA -

Select the type of topdevel source for the project
Topdevel source type:

Schematic |E|

W

| | Cancs

More Info < Back Mext
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8. Set the device properties as shown in the screenshot below. You have to set them
in order from top to bottom. Make sure you have ALL the settings correct before
proceeding. You can change them later, but if they are wrong, certain things will
not work.

9. Click “Next” a few times to go through the rest of the screens and finish the
wizard. These screens allow you add sources to your project, but we will do this
later.

10. Congratulations! You have created your first Xilinx project.

ﬂ Mew Project Wizard - Device Properties ﬁ
Select the device and design flow faor the project

Property Name Walue
Product Categony All E|
Family Virtex2P =]
Device XC2VP30 -
Package FF896 -
Speed -7 E|
Top-Level Source Type Schematic
Synthesis Tool ¥5T (WHDLVerlog) |z|
Simulator ISE Simulator (WHDLAerlog) |z|
Prefemred Language WYHDL |E|
Enable Enhanced Design Summary
Enable Message Filtering [
Display Incremental Messages [

B ] (o
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Schematic Entry
Now, we will create a schematic for the half-adder.

11. Right-click on “MYHA” in the Sources window on the top-left of the workspace,
and click “New Source” (see screenshot below)

Sources for: | Implementation -
B MYHA

i Mew Source...
Add Source...
Add Copy of Source...

Ef$ Sources |E @ Toggle Paths ,E

Properties... —

Processes for: xc2vp 30- AT 896 |

12. Select “Schematic” and type in “MYHA” for the filename (see screenshot below)

+=] New Source Wizard - Select Source Type =)

o IP (CORE Generator & Architecture Wizard)

Verlog Module File name:

L\ Verilog Test Fours

il VHDL Module MYHA |
| P] VHDL Package

] VHDL Test Berch \Ci\user\ YOURNAMENMYHA, | [

Add to project

[ o] [

13. Click “Next” and then “Finish”
14. A blank schematic sheet should now appear.
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15. Now, we need to create 1/O pins to interface with the half adder. Click on
“Tools” in the menu bar, and select “Create /O Markers”

16. We want two inputs (A and B) and two outputs (S for sum and Co for carry-out).
Under “Inputs” type “A,B” and under “Ouputs” (yes, it’s misspelled) type “S,Co”

[ ﬁ Create /O Markers [&r

Inputs
AR

Quputs
S5Co

Bidirection

OK | [ Camcsl || Hep |

L.

17. You can only use the wizard to add pins on an empty schematic. If you need to
add pins after already adding other components to your schematic, use the “Add
I/O Marker” tool in the toolbar, or press CTRL+G. You can only add an 1/0
marker to the end of a wire.

WP p[F[R-8[N0
arll
[add 1/ Marker

18. Next, we have to add the gates necessary for a half adder. The schematic from the
first page is repeated below. The half adder uses two inverters (NOT), three AND
gates, and one OR gate.

19. To add components, go to the “Symbols” menu in the “Sources” window

20. In the “Symbol Name Filter” blank, type in “inv”, click on the “inv” in the list,
and click twice in the workspace (to add two inverters). Press the escape key to
get out of symbol insert mode.

21. Now, add three “and2” modules and one “or2” module

22. Make sure you align your components so they’re roughly organized like the
schematic. This will make it easier to make a clean schematic.

23. Now, it’s time to wire. Click on the wire tool in the toolbar or press CTRL+W

(W for wire... shocking...)
QI [f]ae =8
add wWire
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24. Left-click the spot you want to start a wire, and left-click on the lead of the
component you want to connect it to. Xilinx will automatically lay the wire for
you. If you want to manually make turns, left-click at intermediate spots, and it
will place a junction there so you can “turn” the wire. Pressing the escape key
will get you out of wire mode.

e CEERENERE s i SRRl [ SRR
et = A DD i nsance = XLKTS
" |bort polarity = Input | T e =iy
-ooooooc|Branchcount =1 f.- - SRR
s |0 Marker counk =10 - - confInput  T==

25. Make sure that your wire actually connected the two components. Occasionally,
it will not fully connect, and usually leaves a red box indicating that a wire is not
connected.

26. Use the wire tool to wire your schematic according to the schematic given above.
Once done, you may want to move some components around to make the circuit
clean and readable. This will be even more important as your circuits become
more complex. Your schematic should roughly look like the one below.

S UANDE

27. Now that the schematic is complete, verify that the wires in your schematic are
connected properly. Press the “Check Schematic” button on the toolbar.

28. In the status menu below your schematic, it should say “No error or warning is
detected”

29. Save (as you should anyway be doing frequently.
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Behavioral Simulations (Testing)

As with any software project, you have to test your design to see if it matches the
theoretical expectations. For example, 0+0 should result in 0, not 42. To test a logic
circuit in Xilinx, we run a behavioral simulation. This tests various input
combinations to see if they generate the appropriate output.

30. In the Sources window, go to the drop-down menu labeled “Source for:” and
select “Behavioral Simulation”

31. Right-click on the MYHA project in the Sources window and click on “New
Source” as you did to add the schematic.

32. Select “Test Bench Waveform” and name it MYHAtest

5 MNew Source Wizard - Select Scurce Type lﬁ

BMM File

J IP ({CORE Generator & Architecturs Wizard)
"t | MEM File

| Schematic

"t Implementation Constraints File

State Diagram File name:
n| Test Bench Waveform

=| User Document MYHHEStl
v | Verlog Module Location:

Werlog Test Fidure - - -

"l VHDL Module ChuserYOURNAMENWMYHA E]
WHOL Librany

F | WVHDL Package

'ty WHOL Test Bench

Add to project

< Back [ Nest > ][ Cancel

33. Click Next. Associate your test bench with your MYHA schematic.

34. Click Next and then Finish.

35. After a few seconds, the “Initial Timing and Clock Wizard” window should
appear

36. Select “Combinatorial” under clock, change the “Check Outputs” and “Assign
Inputs” times to 10ns, and uncheck “GSR (FPGA)”
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37. Your settings should match the screenshot below.

=4 Initial Timing and Clock Wizard - Initialize Timing [

Assign Check Assign
Inputs QOutputs Inputs

Wait To Wait To

® Check ™™= Assign -

Clock Timing Information Clock Information

Inputs are assigned at “Input Setup Time" and ™1 Single Clock A
outputs are checked at "Output Valid Delay™. ]
e (7 Multiple Clocks

N — @ Combinatorial {or intemal clock)

Clock High Time | 100 ns Combinatorial Timing Information
Giock Low Time | 100 & Inputs are assigned, outputs are decoded then
checked. A delay between inputs and outputs avoids
Input Setup Time |15 ns assignment /checking conflicts.
Output Valid Delay |15 ns Check Outputzs |10 | ns  After Inputs are Assigned
Offzet |0 ns Assign Inputs |10 | ns After Outputs are Checked
Global Signals
) ] Initial Length of Test Bench: [1000 ns
[[] PRLD {CPLD} [[] GSR(FPGA)
Time Scale: | ns |z|

High far Initial: {100 ns

< Back . Finish | [ Cancsl ]

38. Click Finish

39. A test bench waveform should now appear. The blue shaded areas indicate the
time after which the outputs will be valid (in our case we selected 10ns). By
clicking on a blue space for the waveform of one of your inputs, you can change
the state of that input between low (0) and high (1).

40. Now, to verify that our half adder works for all possible inputs, we need to test the
adder for all possible inputs (AB=00, 01, 10, and 11). For more complex circuits,
you probably will not be able to test all possible inputs. In those cases, you
should test representative cases that, together, prove functionality of your circuit.

41. By clicking on the waveform, set it to input each of the possible inputs, as shown.
You should leave each input steady for a decent period (say 50ns, or 5 cycles) to
allow the output a chance to change values. Your waveform should look like the
one below.
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42. Save your test bench. The MYHAtest.tbw source should now appear in the
Sources window. If you expand it, you will see the source it is linked to, which in
this case is MYHA.sch.

43. It is now time to simulate! In the Processes window (below the Sources window),
expand the “Xilinx ISE Simulator” menu and double-click “Simulate Behavioral
Model”

Processes for: MYHAtest
[ Add Bdsting Source
[ Create New Source
View Generated Test Bench Az HDL
[ Add Test Bench To Project
- %F  Milirec 1SE Simulator
E? D Simulate Behavioral Model

44. Click on the “Zoom to Full View” button on the toolbar (see screenshot). Your
simulation should look like the image below.

45. As expected, the results correspond to the outputs we were expecting: AB=00
gives an output of CoS=00, 10 gives an output of 01, 01 gives an output of 01,
and 11 gives and output of 10.

) & Py JLE A MDA N
gy i I
> AR “*[700m to Full View A = e g

Current Simulation

Time: 1000 ns 100 ns 20 |:|| ns
| |

Te X
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Implementation

Now we would like to implement the half adder on the FPGA board. This involves
adding pin assignments to map the 1/O pins in the design to pins on the FPGA board.
Then, the Xilinx ISE program will synthesize the design for programming the board.
This involves figuring out what LUTs (lookup tables) are needed, how the CLBs
(configurable logic blocks) will be arranged, etc.

46. Switch back to “Implementation” mode by going to the “Sources for:” drop-down
menu in the Sources window

47. In order to use the LEDs on the board, we have to add a pin called LDG. This
corresponds to a flip-flop input on the FPGA chip that effectively turns on LED
functionality.

48. Add the symbol “vcc” to the MYHA.sch schematic using the Symbols window.
This can be placed anywhere.

49. Now, add an 1/0 marker to the end of the vcc component. Double-click on this
I/O marker and name it “LDG” and make sure it is set to “Output” mode.

5 Object Properties - Net Attributes [ﬁ
Category
=) Nets View and edit the attributes of the selected nets

XLXN_29 Name Value Visible [ New ]
=140 Markers Idg| Add
W2 | ooy owpd (s Ada ]

oK ][ Cancel ][ Apply ][ Help
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50. Next, we have to assign the pins to the 1/0O markers. Click on MYHA.sch in the
Sources window. In the Processes window, click on
“Floorplan Area / 10 / Logic — Post-Synthesis”

Processes for: MYHA -
M Add Edsting Source
[ Create New Source
= View Design Summary
‘ﬁ‘ Design Liilties
= $ User Constraints
EEZ Create Timing Constraints
Floorplan 10 - Pre-Synthesis
. Floolan Area / 10 / Logic - Post-Syrthesis
P Syrthesize - XST
{}Olmplemem Design i

4 k

E‘—f' Processes |§;u Options |Q Sim Object | D Hierarchy - b

m

51. Click “Yes” on the popup message to create a UCF (Implementation Constraint
File) in the project

52. The Xilinx PACE program should now be open

53. A list of all the pins in your project should be listed on the left. In the “Loc”
column, you have to enter the pin assignments for each one. Pin assignments are
located on the ESE171 website (link). You may choose any switch/LED you
want, but A and B should be switches, and S and Co should be LEDs. For each of
the pins, a blue dot should appear on the Device Architecture window on the right
side of the editor. Your assignments should look like the image below.

Design Object List - /O Pins =R =<
1/0 Name | 1/0 Direction| Loc | Bank 1/0 51
A input N§ BANK
B Input L5 BANK
Co Output T8 BANK
LDG Output V7 BANK
5 Output U5 BANK

54. Save the file and close the window. If a window asking you to select a Bus
Delimiter appears, select XST default and click OK.

55. Now, you can implement the design. To run through the full synthesis and
implementation sequence, double-click on “Generate Programming File” in the
Processes window. This will generate the Translate, Map and Place & Route
files. A green checkmark will appear next to each step when the process has
finished successfully. If any red X appears, then there was an error. At this stage,
ask a TA for help.
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http://www.seas.upenn.edu/~ese171/boards/DIO4_PinAssignments.pdf

Timing Simulation

At this point, you can verify your design by doing a Post-Place & Route Simulation.
Since the design has been placed on the chip, the system can do a more accurate
simulation that will also give you specific timing information such as the delays of
the output signals.

56.

57.
58.

59.

60.
61.
62.

63.

In the Sources window, go to the “Sources for:” drop-down menu and select
“Post-Route Simulation”.

Select the MYHAtest.tbw source

In the Processes window, expand the Xilinx ISE Simulator menu and double-click
“Simulate Post-Place & Route Model”

This will produce a simulation very similar to the behavioral simulation you did
before. Now, however, the outputs will appear with some delay after the inputs
change. You can measure this delay by zooming in on a specific region and
adding markers. This is very similar to measuring analog circuit delay on an
oscilloscope.

Right-click on the simulation window and select “Add Marker”

Click on a rising/falling edge of the input you want to measure delay from
Repeat step 62 and add a marker to the rising/falling edge of the output that
corresponds to your marked input

You can now calculate the delay by simply subtracting the two times

64. A sample measurement is shown below

Current Simulation
Time: 1000 ns
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Programming the Board
It is finally time to download the circuit to the board!

65. Power the board and connected the USB cable to the computer

66. Turn on the board

67. Open the Windows Start Menu, and in the search field, type “impact”

68. Click on the program “iMPACT (64-bit)”

69. This will open the iIMPACT program, which you will use to download the
programming file (.bit file) to the board.

70. Select “create a new project (.ipf)” and browse to the directory where you saved
your project (C:\use\YOURNAME\MYHA), and name the file myha.ipf

T . ==

| wart to
() load most recent project Browse...
[]; Load most recert project file when iMPACT starts i
@ create a new project (ipf) | myha ipf

71. Click ok to create the IMPACT project
72. Select “Configure devices using Boundary-Scan (JTAG)” on the next screen

Flease select an action from the list below

@ Corfigure devices using Boundary-Scan (JTAG)
Automatically connect to a cable and identify Boundary-Scan chain lz‘
() Prepare a PROM File
() Prepare a System ACE File
() Prepare a Boundary-Scan File
SVF
() Corfigure devices

using Slave Serial mode

< Back Erish | [ Cancel
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73. It will now find and load the board configuration

74. You should now see a chain of three devices you can program and a pop-up
window. Each device programs a different part of the board, like the chip itself
and the PROM (programmable read-only memory).

% iMPACT - C:fuser/YOURNAME/MYHA/myha.ipf - [Boundary Scan] E@il
% File Edit View Operations Options Output Debug Window Help (=)&) ]
PH SDBRX|2=Emn|: |22 30|88
Flows x

‘28 Boundary Scan

‘5ol SlaveSeral

T8 SelectMAP

‘28 Desktop Corfiguration
' ‘23 Direct SPI Corfiguration
[Z] SystemACE

xcf3Zp XCcace xc2vp30
[£] PROM File: Formatter —fie 7 — —file 7 — — file 7 —

E

.
| Modes @ Assign New Configuration File

IMPACT Processes x Look in: |3 C./user/YOURNAME/MYHA/ [z « @& ek EE=
Available Operations are

File type: | All Design Files {".mcs “.exo “isc “bsd) |z|
Operstions 1% Boundary Scan Cancel Al —

|| [ PROGRESS_END - End Operation. @ MNone

l Elapsed time = 0 sec. )

| // #%* BATCH CMD : identifyMPM (7 Enable Programming of SPI Flash Device Attached to this FPGA
‘;;; (7) Enable Programming of BPI Flash Device Attached to this FPGA
SN |
= | Output | Emor | Waming

Configuration | Platform Cable USB | 6 MHz | usbh-fs T

75. Click cancel on the first pop-up window, and then again on the second pop-up
window, to skip the first two program locations
76. On the third window, select myha.bit and click open

F ki
@ Assign Mew Configuration File @lﬂ

Look in: |5 C:/user/YOURNAME/MYHAS E‘ L] 5 %

Emya e

File name: \myha bit Q

Fie type: | All Design Files (*hit “rbt *riky “isc *bsd) [=]

| Concelal |

i
]

@ None
(™) Enable Programming of SP| Hash Device Attached to this FPGA
(=) Enable Programming of BP| Flash Device Attached to this FPGA
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77. Click OK on the next two windows

f Al
% Add Virtex-/1 ProfVirtexd Object Files | BNESS)
Virtexe-l Pro/Virtexd File
Virtexe-ll Pro/Virtexed Configuration File
myha bit
ot P P o e e oA =)
Add... Remove o] - B -
- Boundary-Scan
Propery v
Device 2 ( ACECF, xccace ) ot ame: Blus
BMM Fie Device 3 ( FPGA. x62vp30) Verty (]
(General CPLD And PROM Properties
Erase Before Programming ]
Read Protect ]
PROM/CoclRunmer-I Usercode (8 Hex Digt)
PROM Specific Properties
| Load FPGA =]
Add... ] ’ Remaove Parallel Mode (]
Power PC Software Files
’ Add... ] ’ Remove ]
Associate ELF Tags...
T ] [ew=] | |
[ok [ concsl | [ featr ][ Hen |
L.

78. Right-click on the xc2vp30 chip in the window (the third one) and select Program

i i
TOI § E2xumc ; § Exumc
L ET——
Get Device ID
xcf3Zp xccace b (0% ) )
— file ? — — file? — myt Get Device Signature/Usercode
o Assign Mew Configuration File...
Set Programming Properties...
Set Erase Properties...

79. You should see a blue pop-up message saying ‘“Program Succeeded”
80. Test the functionality of the half adder on the board
81. Congratulations! You have completed your first Xilinx project!
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Snapshots and Archives

At any time, you can take a snapshot of your project. This is a read-only copy of the
current project, similar to taking an image of your computer as a back-up. This allows
you to save different versions of your project in the event something corrupts your
project in the future. A snapshot includes all files and directories associated with a
project.

1. Go to Project > Take Snapshot

2. Name the snapshot (keep it within eight characters) and add a comment if you’d
like that describes it.

3. Snapshots can be viewed by going to the Snapshots tab on the Sources window.

4. You can revert to a snapshot by right-clicking on it and clicking “Make Snapshot
Current”

You can also make an archive of a project. This creates a zip file that contains all
files and directories associated with your project. You cannot open an archived
project from within ISE Project Navigator. To restore an archived project, you first
need to unzip it (using a Windows unzipping utility). Then, open the project as usual
by clicking on the .ise file within the unzipped project folder, or open the .ise file
from Project Navigator by going to File > Open Project.

Updated January 22, 2012 17



